THE BEGINNER’S GUIDE TO MICROSOFT EXCEL

by Sandy Stachowiak
# Table of contents

- What Is Microsoft Excel? .............................................. 4
- General Uses for Excel ............................................. 5
- Basic Excel Terms You Should Know ........................... 5
- The Excel Tabs and Ribbon ......................................... 6
- The Quick Access Toolbar ........................................... 7
- Spreadsheet Options .................................................. 8
- Working With Columns, Rows, and Cells in Excel .......... 9
  - Select an Entire Column or Row ................................. 9
  - Select a Group of Columns, Rows, or Cells ................. 9
  - Select Adjacent Columns, Rows, or Cells ................. 9
  - Select Scattered Columns, Rows, or Cells .................. 10
  - Insert or Delete a Column, Row, or Cell .................... 11
  - Move a Column, Row, or Cell ................................ 12
  - Adjusting the Size of a Column or Row ...................... 13
  - Adjusting the Size to Fit Your Data ........................ 14
- Basic Formatting ....................................................... 15
  - Fonts, Shading, and Colors .................................. 15
  - Dates, Currency, and Decimals ............................... 16
  - Dates .................................................................. 16
  - Currency .............................................................. 17
  - Decimals ............................................................... 18
  - Additional Number Formats .................................... 19
- Simple Formulas: The AutoSum Tool ......................... 19
- Start With an Excel Template .................................... 21
  - Built-In Excel Templates ....................................... 21
  - Third-Party Excel Templates .................................. 22
- Are You Ready to Dig Into Excel? ............................... 23
Microsoft Excel has been around for decades and many have used it since its release. But there are still others who are just now starting to use it. Whether for work, school, or personal use, it can be a little intimidating when you first begin. There are even classes for new Excel users both online and on campuses.

This guide to Excel is for those who have never used it before, are struggling with it as a beginner, or just want the basics to then learn it on their own.

What Is Microsoft Excel?

In the simplest of terms, Excel is a spreadsheet application. It uses grids of cells within columns and rows to manipulate, organize, and perform calculations with data. You can use pivot tables, charts, formulas, and functions in a variety of ways.

That being said, the application is not limited to numbers, although that’s where it “excels.” You can add text, images, videos, objects, and many other items to help track, manage, and easily view information.
General Uses for Excel

- Budgets for household or business finances
- Invoices and receipts
- Tracking for projects, client and customers, and health records
- Planners and calendars
- Checklists and task lists
- Financial, loan, debt, and mortgage calculations
- Inventory management

The list goes on with the many uses for Excel. So, whatever you plan to use it for, let’s look at a few of the terms you will need to know.

Basic Excel Terms You Should Know

Throughout this guide, you will see the same terms used again and again. Getting familiar with them will help you to understand the guide and the steps you see.

**Workbook** and **Spreadsheet**: A workbook is what you actually use when you open Excel. The workbook contains the spreadsheets. A workbook can hold many spreadsheets and you can move between those sheets with the tabs on the bottom of the Excel workbook.

**Cell**: Spreadsheets are made up of rectangular blocks called cells. A cell contains the data you enter; from numbers to words to images to formulas, cells hold that information. You can enter data either directly in the cell or in the formula bar (text box) for the cell right below your ribbon.

You will also notice the name box (cell indicator) to the left of the formula bar. By default, this displays the corresponding column and row for the cell. For instance, the cell in the top left corner of the spreadsheet is A1 for column A, row 1.

**Formulas** and **Functions**: You can think of a formula as a calculation or equation. With Excel, you can create formulas or use built-in ones. These formulas can automatically calculate numbers for you like addition or multiplication.

In addition to calculations, you can use functions for things like counting the number of items in a column or displaying a minimum or maximum number for a group of cells.
The Excel Tabs and Ribbon

You should take a little time to familiarize yourself with the ribbon in Excel. Just like with other Microsoft Office applications, the ribbon holds the buttons that you will use inside tabs. You can customize the ribbon to remove or add both tabs and buttons. But you will likely see the tabs below by default.

Here is a brief explanation of what each one is for and which button sections you can see.

- **File**: Create a new workbook, open an existing one, save, print, and share books and sheets.
- **Home**: Ctrl the clipboard, font, alignment, numbers, style, cells, and editing.
- **Insert**: Insert tables, charts, illustrations, filters, and links.
- **Draw**: Use drawing tools such as a lasso selection, eraser, pen, and highlighter.
- **Page Layout**: Adjust the spreadsheet theme, page setup, scale-to-fit, and sheet options.
- **Formulas**: Pick a formula, function from the library, and perform formula auditing.
- **Data**: Get and transform data, view queries and connections, sort, filter, and use data tools.
- **Review**: Use tools for proofreading, accessibility, language, and comments.
- **View**: Change the workbook view, items to show, zoom in or out, and work with windows.

Also, note the **Tell me what you want to do** box. If you need help or want more information on a feature, just enter the keyword into the box and view your results.
The Quick Access Toolbar

As with the tabs and ribbon, if you use other Microsoft Office applications you should be familiar with the **Quick Access Toolbar**. But if not, this is the toolbar at the very top left of the Excel window. And it is important because it allows you to quickly undo or redo an action, plus save your file.

If you make a mistake and want to undo it, just click the **Undo** button. If you click it once, it will undo the last action you took. If you keep clicking it, it will undo actions you took one-by-one moving backward. Alternatively, you can click the arrow next to the **Undo** button and highlight all actions you want to undo.

If you undo an action with the button, the **Redo** button will then be clickable. This lets you redo what you have just undone. Like the **Undo** button, you can redo your last action with one click or use the arrow next to the **Redo** button to redo multiple actions.

The **Save** button lets you quickly save the file you are working on with the current file name.
Spreadsheet Options

Managing a large number of spreadsheets is no problem for Excel. So, you can use more than one if your project calls for it. For example, you can use different spreadsheets for months or years, product warehouse locations, loan or credit card companies, and healthcare facilities.

Along with multiple sheets, you can take advantage of these basic spreadsheet features.

- **Add a spreadsheet**: Click the plus button at the bottom next to your last sheet.

- **Rearrange spreadsheets**: Hold the sheet tab and drag to its new spot in the workbook.

- **Name a spreadsheet**: Double-click the sheet tab and type the new name. By default, you will see them named Sheet 1, Sheet 2, and so on.

- **Color a spreadsheet tab**: Right-click the sheet tab and under Tab Color, just click to apply a new one.

- **Protect a spreadsheet**: Right-click the sheet tab and under Protect Sheet, add a password and select your options.

- **Move or copy a spreadsheet**: Right-click the sheet tab and select Move or Copy. You can then move the sheet to another spot in the workbook, move it to a different workbook, and make a copy of it for either case.

- **Delete a spreadsheet**: Right-click the sheet tab and click Delete. You will need to confirm this action in the subsequent pop-up window.
Working With Columns, Rows, and Cells in Excel

There are some basics such as selecting, inserting, deleting the columns, rows, and cells in Excel. These are **handy actions to keep in mind** as you work with your spreadsheets.

Select an Entire Column or Row

You will notice as you move your mouse over the letters for the columns or numbers for the rows that a small arrow will appear. If you click at that time, the entire column or row will be selected. You might use this action for applying a function, formatting, or sorting.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td><strong>Item Number</strong></td>
<td><strong>Product Name</strong></td>
<td><strong>Price</strong></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>47715</td>
<td>iPhone Case</td>
<td>$23</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>47716</td>
<td>iPad Case</td>
<td>$33</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>47717</td>
<td>Galaxy Phone Case</td>
<td>$20</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>47718</td>
<td>iPhone Screen Protector</td>
<td>$10</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>47719</td>
<td>iPad Screen Protector</td>
<td>$12</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>47720</td>
<td>Galaxy Phone Screen Protector</td>
<td>$10</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Select a Group of Columns, Rows, or Cells

There may be times when you want to select more than one column, row, or cell. You can do this in a couple of different ways depending on if they are adjacent or scattered.

Select Adjacent Columns, Rows, or Cells

When you want to select columns, rows, or cells that are next to each other, begin by selecting the first one. Then, hold down your mouse button and drag through the rest. You will see them highlight as they are selected. Release the mouse button when you finish.
Another way to do this is to select the first one, hold down your **Shift** key, and then select the last one. If you do this with cells, you can select an entire group across and down.

Select Scattered Columns, Rows, or Cells

If you would like to select columns, rows, or cells that are not adjacent, start by clicking the first one. Then, hold down the **Ctrl** key and continue clicking the ones you want. Release the **Ctrl** key when you finish.
Insert or Delete a Column, Row, or Cell

You can easily add or get rid of a column or row that you no longer need. Again, put your mouse over the letter or number, but instead of left-clicking your mouse, right-click. In the context menu that appears, select either Insert or Delete.

You can also simply hide (and unhide) columns or rows by selecting Hide (or Unhide) from the context menu.

You can insert or delete a cell the same way as a column or row. However, with either option, you will receive a pop-up alert asking how you would like to shift the cells, row, or column. Just choose an option and click OK.
Move a Column, Row, or Cell

If you decide to move a column, row, or cell to a different spot in your spreadsheet, you can do it but must be careful. First, select the column, row, or cell as described above. Put your mouse over one of the edges of it so that the four-sided arrow appears. Then, drag it by holding down your mouse button to its new location and release.
What you must be cautious of is if you release the column, row, or cell over the top of one that already contains data. If this happens, a pop-up box will appear asking if you are sure you want to replace the data. So, if you do this in error, click **Cancel** and it will go back to its original spot. But if it’s your intent to replace the data, click **OK**.

---

### Adjusting the Size of a Column or Row

You may want all or some of the columns or rows on your spreadsheet to be a specific size regardless of the data they hold. Adjusting the width or height is simple and can be done in two different ways.

First, you select and right-click the column or row. In the context menu choose either **Column Width** or **Row Height**, depending on which one you want to change. In the pop-up window that appears, you will see the current width or height. Replace it with the number you want and click **OK**.

Another way to adjust the size of a column or row is to first select it. Move your mouse to the border until you see a two-sided arrow appear. Then, hold down your mouse button and drag until you reach the size you want.
Adjusting the Size to Fit Your Data

If you would rather have each column and row sized to accommodate your data, you can do this in just a few clicks. First, select the entire spreadsheet by clicking the triangle in the upper left corner between the A and the 1.

Then, move your mouse between two columns until you see the two-sided arrow and double-click. Next, do the same for the rows. You will notice both columns and rows of the spreadsheet adjust to fit the data in your cells. It will automatically adjust for the cell with the longest amount of data.
Basic Formatting

Excel offers a variety of ways to format your spreadsheets, from basic to advanced. Since this is a beginner’s guide, we will go through some simple formatting tips that you would likely use.

Fonts, Shading, and Colors

No matter what you decide to use Excel for, basic formatting of columns, rows, and cells can help you view your data easily. For instance, you may use the first row of a spreadsheet to insert headers. Like in our example for a product sheet, you might use item number, product name, and price.

To make that top row stand out better from a large amount of data beneath, you can format it easily. Select the row and then apply your formatting using options on the Home tab. Here, you may make the font bold, apply a fill shade, and color the font.

1. Select the top row.
2. Click the Bold
3. Click the arrow next to the Fill Color and pick a color.
4. Click the arrow next to the Font Color and pick a color.

Keep in mind that these instructions will apply to the entire first row. If you only have a few columns, you can follow the steps further above to only select certain cells in that row and apply the formatting to them alone.
Dates, Currency, and Decimals

If you are creating a tracking spreadsheet, automatic formatting for dates, currency, and decimals is convenient. And you can apply each of these formatting rules in just a few clicks from the Home tab.

Dates

You may have a Date column on your spreadsheet for many reasons. When you enter the data, when you make a purchase, or when an item is due are all just examples.

1. Select the column, row, or cell where you will enter the date.
2. Under Number on your ribbon, click the arrow in the General
3. Select either Short Date or Long Date from the dropdown box.

Note that if you use the Long Date, which inserts words and numbers as shown below, you do not have to type it in manually. For instance, if you apply a Long Date and enter “2/14/18” it will automatically populate as “Wednesday, February 14, 2018.”
If you have a spreadsheet for your budget, price list, or invoicing, then you can apply the currency format easily in two different ways.

Method One

1. Select the column, row, or cell where you will enter the currency.
2. Under **Number** on your ribbon, click the arrow in the **General**
3. Select **Currency** from the dropdown box.

Method Two

The second method allows you to choose the type of currency you would like.

1. Select the column, row, or cell where you will enter the currency.
2. Under **Number** on your ribbon, click the arrow next to the **Currency**
3. Select the type of currency you wish to apply.

Whichever method you decide to use, any number that you enter into the applied columns, rows, or cells will automatically be formatted as that currency.
You can use the decimal formatting to adjust your currency or simple numbers. For instance, you may be tracking your student’s grades or even your own where you need decimals. You can apply this formatting with these two steps.

1. Select the column, row, or cell where you will enter the number.

2. Under **Number** on your ribbon, click either the **Increase Decimal** or **Decrease Decimal** button depending on your current numbering format.
You will also notice under **Number** on your **Home** tab, many additional ways to format your numbers. As you progress with Excel, these may come in handy.

These options include times, fractions, percentages, and others. Plus, you can click the **More number formats** link at the bottom to see options like ZIP code, phone number, and custom choices.

**Simple Formulas: The AutoSum Tool**

One of the best **time-saving features in Excel** is the **AutoSum** tool. It’s easy to use and can help reduce calculation errors. And if you are using Excel for a project like income and expenses or loan and debt management, you will appreciate the AutoSum feature.

This uncomplicated formula tool can add, average, count numbers, or find the minimum or maximum for a column, row, or group of cells. By default, you should see the **AutoSum** button on your **Home** tab ribbon, all the way to the right. You can also access it from the **Formulas** tab.
If you just click the **AutoSum** button, it will automatically insert the sum function. But if you click the arrow for the button, you will see the other common formulas you can use mentioned above.

Say that you have a column of numbers you would like to add. First, click the cell where you would like the total to display. Next, click the **AutoSum** button. Excel will automatically detect the numbers you want to add. They will be highlighted and you can see the formula which may appear something like this: \(=\text{SUM}(C2:C7)\)

**Note:** The *equal sign* indicates a formula. **SUM** is the function. And **C2:C7** are the cells that apply.

If this looks correct for you, just hit your **Enter** key. The calculation will pop into the cell adding those numbers for you.

The other options within AutoSum work similarly. Maybe you need to get the average of a group of cells. First, click the cell where you want the average to display. Next, click the arrow for the **AutoSum** button. Again, Excel will automatically detect the numbers, highlight the cells, and provide the formula. Click the **Enter** key to insert the average.
As we mentioned in the Basic Terms for Excel section, there are many formulas and functions that you can use. Some, like AutoSum, provide very simple and commonly-used calculations. But many others are advanced and beyond the scope of this beginner's guide. Feel free to check them all out on the Formulas tab if you like to experiment.

Start With an Excel Template

One of the best ways to get started in Excel is to use a template. And you will find a large variety of options both within Excel and on external sites.

Built-In Excel Templates

To view options within Excel, click File > New. You will then see a number of featured templates you can use, categories you can pick from, and a search box if you want something specific.

Built-in templates range from simple calendars and planners to elaborate financial reports and balance sheets. But there is a template for almost any common use that you would want in Excel.

If you see a template you would like to view, click on it and then review its description and download size in the pop-up window. If you want to use it, click the Create button.
Third-Party Excel Templates

If you would like to venture out and take a look at external templates, we have a variety of suggestions for you depending on your need.

- The Best Productivity Templates for Microsoft Excel to Get Things Done
- 10 Helpful Spreadsheet Templates To Help Manage Your Finances
- 10 More Spreadsheet Templates to Manage Your Money
- Tips & Templates for Creating a Work Schedule in Excel
- How to Make Your Project a Success with Excel Templates
- Turn Excel Into a Tax Calculator With These Templates

Once you get the hang of using Excel, you can also create your own templates to use again and again. From fundraising tools to helpful calendars, saving a spreadsheet you create as a template is easier than you think.
Are You Ready to Dig Into Excel?

Hopefully, this beginner’s guide will get you on your way to a great experience with Microsoft Excel. There are many features and functions that can be intimidating to brand new users. But those you see here should help you learn as you go when creating your first workbook full of spreadsheets. If you have other tips for new users, let us know in the comment section!

Read more stories like this at

Copyright © 2018 MakeUseOf. All Rights Reserved ©.